
Fiche technique du modèle 3001

Instrumentation de haute qualité pour la surveillance des eaux souterraines et de surface

®Solinst et Levelogger sont des marques déposées de Solinst Canada Ltd.

Levelogger série 5

®Hastelloy est une marque déposée de Haynes International Inc.

Caractéristiques améliorées 
• Stabilité accrue pour la communication  : interface 

optique à œil unique, plus facile à nettoyer et plus 
résistante aux rayures

• Mémoire accrue: 150 000 jeux de données
• Conception plus solide et plus robuste : double joint 

torique pour une protection accrue contre les fuites
• Meilleure sensibilité de la thermistance : RTD en platine 

amélioré
• Protection supérieure dans les environnements difficiles : 

revêtement résistant à la corrosion et à l'abrasion, à 
l'intérieur comme à l'extérieur

• Logiciel Levelogger amélioré : utilitaire de diagnostic 
amélioré pour des "auto-tests" plus proactifs de l'utilisateur

Le Levelogger 5 est doté d'une interface optique 
simple et fluide, qui permet un nettoyage facile 
et une communication plus fiable et plus rapide. 
En utilisant un périphérique USB Solinst, y 
compris le nouveau Field Reader 5 et le logiciel 
PC Levelogger, les vitesses de programmation 
et de téléchargement des données sont de 57 
600 bps.

Communication flexible
Le logiciel Levelogger est rationalisé, ce qui facilite la 
programmation des enregistreurs de données, ainsi que la 
visualisation et la compensation des données au bureau ou sur le 
terrain. La compensation des données est simplifiée ; plusieurs 
fichiers de données peuvent être compensés barométriquement 
à la fois. 

L'interface de l'application Levelogger 5 sur vos Leveloggers sur 
le terrain crée une connexion Bluetooth® entre vos enregistreurs 
de données et l'application Solinst Levelogger sur votre appareil 
intelligent. L'unité de lecture Solinst (SRU) se connecte à vos 
Leveloggers déployés pour afficher et enregistrer les relevés de 
niveau d'eau en temps réel qui sont automatiquement compensés 
barométriquement. Également en option, le DataGrabber 5 est 
une unité de transfert de données USB prête à l'emploi.

Les options de surveillance à distance comprennent le 
LevelSender 5, un dispositif simple et compact qui s'adapte 
parfaitement à un puits de 2", les systèmes de télémétrie STS 
et la liaison radio à distance RRL. En outre, les enregistreurs 
de données de la série Levelogger 5 sont compatibles avec la 
norme SDI-12.

Levelogger® 5
Modèle 3001

Le Levelogger 5 enregistre des mesures très précises du niveau 
et de la température des eaux souterraines et de surface. Il 
combine un capteur de pression, un détecteur de température, 
une pile au lithium de 10 ans et un enregistreur de données, 
scellés dans un boîtier en acier inoxydable de 22 mm x 160 mm 
(7/8" x 6,3") avec un revêtement résistant à la corrosion cuit à 
l'aide de la technologie de polymérisation.

Le Levelogger 5 mesure la pression absolue à l'aide d'un capteur 
de pression Hastelloy® , offrant une haute résolution et une 
précision de 0,05 % FS. Les lectures sont stables dans des 
conditions de pression et de température extrêmes. Le capteur 
Hastelloy peut supporter une surpression 2 fois sans dommage 
permanent. Combiné avec le revêtement durable à l'intérieur et à 
l'extérieur, le Levelogger 5 a une résistance élevée à la corrosion 
et à l'abrasion dans les environnements difficiles. 

Le Levelogger 5 utilise une conception de cage de Faraday, qui 
protège contre les surtensions ou les pointes électriques causées 
par la foudre. Sa conception durable sans entretien, sa précision 
et sa stabilité élevées font du Levelogger 5 l'instrument le plus 
fiable pour l'enregistrement continu et à long terme du niveau 
d'eau.

Applications
• Caractérisation d'aquifères : tests de pompage, tests de 

slug, etc.
• Surveillance d’une ligne de partage des eaux, d’un bassin 

d’évacuation ou d’un bassin de recharge
• Jaugeage des cours d'eau, gestion des lacs et réservoirs
• Mesure de la fluctuation du port et des marées
• Surveillance des zones humides et du ruissellement des 

eaux pluviales
• Alimentation en eau et mesure du niveau du réservoir
• Gestion des eaux de mine et des lixiviats de décharge
• Surveillance à long terme du niveau de l'eau dans les 

puits, les masses d'eau de surface et les environnements 
d'eau de mer

Vitesses de communication et de téléchargement 
rapides avec un Field Reader 5 haute vitesse

Interface optique 
à œil unique

Plus d’infos | Instructions | Obtenir un devis 

https://www.solinst.com/francais/produits/enregistreurs-de-donnees-et-de-telemetrie/3001-serie-levelogger/levelogger/fiche-technique/01-fiche-technique.php?utm_source=solinst-&utm_medium=DS-&utm_campaign=3001-WC-&utm_term=DT-global-&utm_content=DS-FR-3001-moreinfo
https://www.solinst.com/francais/produits/enregistreurs-de-donnees-et-de-telemetrie/3001-serie-levelogger/mode-de-emploi/instructions.php?utm_source=solinst-&utm_medium=DS-&utm_campaign=3001-WC-&utm_term=DT-global-&utm_content=DS-FR-3001-ins
https://www.solinst.com/francais/produits/enregistreurs-de-donnees-et-de-telemetrie/3001-serie-levelogger/get-quote.php?utm_source=solinst-&utm_medium=DS-&utm_campaign=3001-WC-&utm_term=DT-global-&utm_content=DS-FR-3001-getquote
https://www.solinst.com/francais/produits/enregistreurs-de-donnees-et-de-telemetrie/3001-serie-levelogger/get-quote.php?utm_source=solinst-&utm_medium=DS-&utm_campaign=3001-WC-&utm_term=DT-global-&utm_content=DS-FR-3001-getquote
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Configuration de l'enregistreur de niveau
La programmation des Leveloggers est extrêmement intuitive. 
Connectez-vous simplement à un PC à l'aide d'un lecteur optique 
(Desktop Reader 5 ou Field Reader 5) ou d'un câble d'interface 
PC. Utilisez un seul écran pour remplir les informations de 
votre projet et le régime d'échantillonnage. Des modèles de 
paramètres peuvent être enregistrés pour une réutilisation facile. 

L'heure du Levelogger peut être synchronisée avec l'horloge de 
l'ordinateur. Il existe des options pour le démarrage immédiat 
ou les heures de démarrage et d'arrêt futures. Le pourcentage 
d'autonomie restante de la batterie et la quantité de mémoire 
libre sont indiqués sur l'écran des paramètres. 

Les enregistreurs de niveau peuvent également être programmés 
avec un régime d'échantillonnage et des heures de démarrage/
d'arrêt à l'aide de l'application Solinst Levelogger sur votre 
appareil intelligent.

Options d'échantillonnage pratiques
Les enregistreurs de niveau peuvent être programmés avec un 
programme d'échantillonnage linéaire, basé sur des événements 
ou sélectionnable par l'utilisateur. L'échantillonnage linéaire peut 
être réglé de 1/8 seconde à 99 heures.

L'échantillonnage basé sur les événements peut être configuré 
pour enregistrer lorsque le niveau change d'un seuil sélectionné. 
Les lectures sont vérifiées à l'intervalle de temps sélectionné, 
mais enregistrées en mémoire uniquement si la condition est 
remplie. Une lecture par défaut est effectuée toutes les 24 
heures si aucun « événement » ne se produit.  

L'option Planification permet jusqu'à 30 éléments de 
planification, chacun avec son propre taux d'échantillonnage et 
sa propre durée. Pour plus de commodité, il existe une option 
pour répéter automatiquement le calendrier.

Téléchargement, visualisation et exportation 
de données
Il est possible de télécharger les données sur un PC par un 
simple clic sur une icône à l’écran. De nombreuses options sont 
offertes pour le téléchargement de données, y compris « Append 
Data» (Ajouter les données) et « All Data » (Toutes les données). 
Le logiciel permet également de visualiser immédiatement les 
données sous forme graphique ou tabulaire en utilisant « Real 
Time View » (Visualisation en temps réel). 

Les données de niveau sont automatiquement compensées pour 
la température  ; les données de température sont également 
téléchargées. La compensation barométrique des données 
du Levelogger est effectuée à l'aide de l'assistant de données, 
qui peut également être utilisé pour saisir les ajustements 
manuels des données, l'élévation, les décalages, la densité et 
ajuster l'efficacité barométrique. Le logiciel Levellogger permet 
d'exporter facilement les données dans une feuille de calcul ou 
une base de données pour un traitement ultérieur.

L'application Solinst Levelogger vous permet également 
de visualiser et de sauvegarder les données en temps réel ou 
enregistrées directement sur votre appareil intelligent, ou vous 
pouvez visualiser et sauvegarder les données en utilisant un SRU. 

Utilitaires utiles
L'utilitaire de diagnostic peut être utilisé en cas de problème 
inattendu. Il vérifie le fonctionnement du programme, des 
mémoires d'étalonnage, de sauvegarde et d'enregistrement, du 
transducteur de pression, du capteur de température et de la 
tension de la batterie, et permet un vidage mémoire complet, si 
nécessaire. Une mise à niveau du micrologiciel sera disponible 
de temps en temps, pour permettre la mise à niveau du 
Levelogger 5, à mesure que de nouvelles fonctionnalités sont 
ajoutées.
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®Kevlar est une marque déposée de DuPont Corp.

Câbles de lecture directe L5
Lorsqu'il est souhaité d'obtenir 
des données en temps réel et de 
communiquer avec les Leveloggers 
sans les sortir de l'eau, ils peuvent être 
déployés à l'aide de câbles à lecture 
directe L5. Cela permet de visualiser 
les données, de les télécharger et de 
les programmer sur le terrain à l'aide 
d'un PC portable ou de l'interface 
Solinst Levelogger 5 App. Vous pouvez 
visualiser et enregistrer les données dans 
un SRU, ou simplement les télécharger 
avec un DataGrabber 5.

Les enregistreurs de niveau peuvent être 
connectés à une centrale de mesure SDI-
12 à l'aide du câble d'interface Solinst 
SDI-12 attaché à un câble de lecture 
directe L5.  

Spécifications des câbles
Les câbles de lecture directe L5 sont 
disponibles pour être fixés à n'importe 
quel enregistreur de niveau dans des 
longueurs allant jusqu'à 1500 pi. Le 
diamètre de 3,175 mm. Le câble 
coaxial (1/8 ") a une gaine extérieure 
en polyuréthane pour plus de résistance 
et de durabilité. Le conducteur en acier 
inoxydable toronné offre une précision 
non extensible.

Déploiement de câble standard
Les enregistreurs de niveau peuvent être suspendus à un 
câble en acier inoxydable ou à un cordon en Kevlar ® . Il 
s'agit d'une méthode de déploiement très peu coûteuse 
et, s'il est dans un puits, permet au Levelogger d'être 
facilement verrouillé hors de vue et inaccessible. Solinst 
propose des assemblages de câbles et de cordons dans 
une variété de longueurs. 

Ensemble de capuchon de puits Solinst 
3001 
Les capuchons de puits verrouillables de 2" sont conçus 
pour les options de déploiement de câbles à lecture 
directe et standard.

Le capuchon du puits a un œillet pratique pour suspendre 
les Leveloggers à l'aide d'un câble ou d'un cordon 
en Kevlar. L'insert Well Cap a deux ouvertures pour 
accueillir des câbles de lecture directe pour un Levelogger 
et un Barologger. Des adaptateurs sont disponibles pour 
s'adapter aux puits de 4". 

Le bouchon est ventilé pour égaliser la pression 
atmosphérique dans le puits. Il se glisse sur le boîtier et 
peut être sécurisé à l'aide d'une serrure avec un diamètre 
d'anse de 9,5 mm (3/8").

Installations de bouchons de puits verrouillables Levelogger 2" 
(voir la fiche technique Well Caps pour plus de détails)

Barologger 5 et Levelogger 5 
installés dans un puits à l'aide 
de câbles de lecture directe L5

Interface de l'application Levelogger 5
L'interface de l'application Levellogger 5 utilise Bluetooth® 
technologie pour connecter votre Levellogger à votre appareil 
intelligent. Avec l'application Solinst Levelogger, vous pouvez 
télécharger des données, afficher des données en temps 
réel et programmer vos Leveloggers. Les données peuvent 
être envoyées par e-mail depuis votre appareil intelligent 
directement à votre bureau (voir les fiches techniques de 
l'interface d'application du modèle 3001 Levelogger 5).
®Le logo Apple est une marque commerciale d'Apple Inc., déposée aux États-Unis et dans 
d'autres pays. App Store est une marque de service d'Apple Inc. Google Play est une marque 
de Google Inc. 
Lamarque et les logos Bluetooth ® sont des marques déposées appartenant à Bluetooth SIG, Inc. et toute 
utilisation de ces marques par Solinst Canada Ltd. est sous licence.

https://itunes.apple.com/us/app/solinst/id854408232
https://www.solinst.com/francais/produits/enregistreurs-de-donnees-et-de-telemetrie/3001-serie-levelogger/interface-app-levelogger/fiche-technique/01-apple-fiche-technique.php?utm_source=solinst-&utm_medium=DS-&utm_campaign=3001appint-WC-&utm_term=DT-global-&utm_content=DS-FR-3001-appint
https://play.google.com/store/apps/details?id=com.solinst.solinstandroidapp&hl=en
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Spécifications du Levelogger 5
Capteur de niveau : Silicium piézorésistif avec capteur en Hastelloy

Précision : ± 0,05 % FS (Barologger 5 : ± 0,05 kPa)

Stabilité des mesures : Excellente, bruit faible

Résolution: 0,002 % FS à 0,0006 % FS

Unités de mesure: m, cm, pi, psi, kPa, bar, ºC. ºF (Barologger 5: psi, 
kPa, mbar, ºC, ºF)

Normalisation: Compensation automatique de la température

Plage de comp. de temp 0º à 50ºC (Barologger 5: -10 à +50ºC)

Capteur de température: Thermomètre à résistance de platine (RTD)

Précision du capteur de 
temp. :

± 0,05 ºC

Résolution du capteur de 
temp :

0.003°C

Autonomie des piles : 10 ans – basé sur 1 lecture/minute

Précision de l'horloge 
(typique) :

±1 minute/an (à des températures comprises 
entre -20 et 80 °C)

Température de 
fonctionnement :

-20ºC à 80ºC

Nombre maximal de relevés : 150 000 ensembles de données.

Mode mémoire : Ardoise et Continu

Communication : Haut débit optique : USB, SDI-12
57 600 bps avec USB

Taille: 22 mm x 160 mm (7/8" x 6,3")

Poids: 146 grammes (5,2 onces)

Résistance à la corrosion: Revêtement cuit au four utilisant la technologie 
de polymérisation (intérieur et extérieur)

Autres matériaux mouillés : Delrin®, Viton®, acier inoxydable 316L, Hastelloy, 
Revêtement PTFE sans PFAS

Modes d’échantillonnage : Linéaire, événement et sélectionnable par 
l'utilisateur avec mode de répétition, démarrage 
futur, arrêt futur, vue en temps réel

Fréquence des mesures : 1/8 s à 99 heures

Barométrique 
Compensation:

Assistant logiciel et un Barologger 5 dans la 
zone locale (rayon d'environ 30 km/20 miles)

Les enregistreurs de niveau mesurent la pression absolue 
(pression de l'eau + pression atmosphérique) exprimée en 
pieds, mètres, centimètres, psi, kPa ou bar.

La méthode la plus précise pour obtenir des changements 
de niveau d'eau consiste à compenser les fluctuations de 
la pression atmosphérique à l'aide d'un Barologger 5, en 
évitant les décalages dans la compensation. 

Le Barologger 5 est installé au-dessus du niveau d'eau 
élevé en un seul endroit sur le site. Un Barologger peut 
être utilisé pour compenser tous les Leveloggers dans un 
rayon de 30 km (20 miles) et/ou avec chaque changement 
d'altitude de 300 m (1000 ft.). 

L'assistant de compensation de données du logiciel 
Levelogger produit automatiquement des fichiers de 
données compensés à l'aide des fichiers de données 
synchronisés du Barologger et des Leveloggers sur site.

Le Barologger 5 utilise des algorithmes de pression basés 
sur la pression de l'air plutôt que celle de l'eau, offrant une 
précision supérieure. 

Les informations barométriques enregistrées peuvent 
également être très utiles pour aider à déterminer le 
décalage barométrique et/ou l'efficacité barométrique de 
l'aquifère surveillé. 

Le Barologger 5 enregistre la pression atmosphérique en 
psi, kPa ou mbar. Lors de la compensation de données 
Levelogger 5, Edge, Gold ou Junior submergées, le 
logiciel Levelogger peut reconnaître le type de Levelogger 
et compenser en utilisant les mêmes unités trouvées dans 
le fichier de données submergées (par exemple pieds ou 
mètres). Cela rend le Barologger 5 rétrocompatible.

Compensation barométrique précise

Synchronisez et simplifiez la 
compensation barométrique 
sur l'ensemble du site



Levelogger série 5

Solinst Canada Ltd. 35 Todd Road, Georgetown, Ontario  Canada  L7G 4R8  www.solinst.com
E-mail : instruments@solinst.com   Tél. : +1 (905) 873-2255 ; (800) 661-2023   Fax : +1 (905) 873-1992
9 novembre 2021

Télémétrie LevelSender 5 
Le LevelSender 5 est un système de 
télémétrie simple et peu coûteux conçu 
pour envoyer des données des Leveloggers 
sur le terrain à votre appareil intelligent et 
à la base de données de votre PC via une 
communication cellulaire. 

La configuration initiale s'effectue via un 
assistant logiciel convivial sur la station 
d'accueil. Il existe une communication 
bidirectionnelle entre le LevelSender 5 et 
la Home Station, permettant des mises à 
jour à distance.

Chaque appareil LevelSender 5 dispose 
d'un seul port pour connecter un Levelogger 
avec un séparateur en option qui permet la 
connexion de deux.  

Les stations LevelSender 5 sont de 
conception compacte, ce qui leur permet 
d'être discrètement installées dans un puits 
de 2" (50 mm) (voir la fiche technique du 
modèle 9500).

Enregistrement de données à faible coût  : Voir la fiche 
technique du Levelogger 5 Junior.
Enregistreurs de données ventilés : Voir les fiches techniques du 
LevelVent 5 et de l'AquaVent 5.
Enregistrement des données de conductivité  : Voir la fiche 
technique du Levelogger 5 LTC.

Modèles Pleine échelle (FS) Précision Résolution
Barologue Aérien seulement ± 0,05 kPa 0,002 % FS

M5 5 m (16.4 ft.) ± 0,3 cm (0,010 pi) 0,001% FS

M10 10 m (32.8 ft.) ± 0,5 cm (0,016 pi) 0,0006 % FS

M20 20 m (65.6 ft.) ± 1 cm (0,032 pi) 0,0006 % FS

M30 30 m (98.4 ft.) ± 1,5 cm (0,064 pi) 0,0006 % FS

M100 100 m (328.1 ft.) ± 5 cm (0,164 pi) 0,0006 % FS

M200 200 m (656.2 ft.) ± 10 cm (0,328 pi) 0,0006 % FS

® Delrin et Viton sont des marques déposées de DuPont Corp.

DataGrabber 5
Le DataGrabber 5 est un dispositif de transfert de données prêt 
à l'emploi qui vous permet de copier les données d'un limiteur 
de vitesse sur une clé USB (clé double USB et USB-C fournie).
Le DataGrabber 5 est compact et très facile à transporter. Il 
se connecte à l'extrémité supérieure du câble de lecture directe 
d'un Levelogger, ou directement à un Levelogger en utilisant 
un adaptateur. Un seul bouton-poussoir permet de télécharger 
toutes les données de la mémoire d'un limiteur de vitesse sur un 
périphérique USB. 

Télémétrie STS
STS Telemetry fournit une méthode efficace pour envoyer 
les données du limiteur de vitesse du terrain à votre bureau. 
Les options de communication cellulaire offrent la flexibilité 
nécessaire pour s'adapter à tous les projets. Les systèmes 
STS sont conçus pour réduire les coûts en permettant 
l'autogestion des données. La notification d'alarme, les mises 
à jour à distance du micrologiciel et les rapports de diagnostic 
simplifient la maintenance du système (voir la fiche technique 
du modèle 9100).

RRL Liaison radio à distance
La liaison radio à distance RRL est idéale pour les applications 
en boucle fermée et à courte portée, jusqu'à 30 km (20 miles). 
La RRL peut être reliée à une station de télémétrie STS pour 
passer d'un système de télémétrie en boucle fermée à un système 
accessible de n'importe où grâce à la connectivité Internet. (voir 
la fiche technique du modèle 9200).

Unité de lecture de solinst (SRU) 
Connectez un SRU à un limiteur de niveau sur le terrain via un 
câble de lecture directe L5 ou un adaptateur fileté ou coulissant 
L5 pour afficher les relevés instantanés du niveau d'eau, l'état du 
limiteur, enregistrer une session d'enregistrement en temps réel 
et télécharger les données dans la mémoire du SRU.

https://www.solinst.com?utm_source=solinst-&utm_medium=DS-&utm_campaign=3001-WC-&utm_term=DT-global-&utm_content=DS-FR-3001-footerhome
mailto:instruments%40solinst.com?subject=
https://www.solinst.com/francais/produits/enregistreurs-de-donnees-et-de-telemetrie/3001-serie-levelogger/levelogger-junior/fiche-technique/01-fiche-technique.php?utm_source=solinst-&utm_medium=DS-&utm_campaign=3001jr-WC-&utm_term=DT-global-&utm_content=DS-FR-3001-3001jr
https://www.solinst.com/francais/produits/enregistreurs-de-donnees-et-de-telemetrie/3001-serie-levelogger/levelogger-ltc/fiche-technique/01-fiche-technique.php?utm_source=solinst-&utm_medium=DS-&utm_campaign=3001ltc-WC-&utm_term=DT-global-&utm_content=DS-FR-3001-3001ltc
https://www.solinst.com/francais/produits/enregistreurs-de-donnees-et-de-telemetrie/9500-levelsender/levelsender.php?utm_source=solinst-&utm_medium=DS-&utm_campaign=9500-WC-&utm_term=DT-global-&utm_content=DS-FR-3001-9500
https://www.solinst.com/francais/produits/enregistreurs-de-donnees-et-de-telemetrie/3500-aquavent/fiche-technique/01-fiche-technique.php?utm_source=solinst-&utm_medium=DS-&utm_campaign=3500-WC-&utm_term=DT-global-&utm_content=DS-FR-3001-3500

